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1

Installation Overview and

Platform Requirements
This manual tells how to install MATRIXX
® Product Family release 7.X. If you 

plan to install RealSim™, complete the installation described in this manual, and 
then proceed to the RealSim PC Controller Installation Guide (Windows Version) or 
the RealSim AC-1000 Controller Installation Guide (Windows NT Version).

1.1 Manual Organization

This manual includes the following:

■ Chapter 1 (this chapter) defines the MATRIXX 7.X installation and platform 
requirements.

■ Chapter 2, Software Structure, describes the MATRIXX Product Family 
directory structure and planning options.

■ Chapter 3, Licensing and Terminology, describes licensing-related 
terminology and tasks.

■ Chapter 4, Installation and Related Tasks, gives a detailed explanation of the 
MATRIXX 7.X installation procedure and related tasks. 
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■ Chapter 5, FLEXlm Licensing Tools, discusses the MATRIXX 7.X license 
manager utilities, license manager debugging, and daemon log file.

This guide also has an Index.

1.2 Installation Overview

MATRIXX 7.X includes installation software that performs a complete installation 
for the product. This includes three setup types as described in Table 1-1.

The installation software includes the Flexible License Manager (FLEXlm®). 
RealSim is available as an option.

1.3 Platform Requirements

Wind River supports the MATRIXX 7.X software in the hardware and software 
environments described in the following sections. 

Table 1-1 Setup Types

Type Description

Client Installs client software only.

Server Installs the product software on a network server (Windows NT only).

Standard Installs the product software on a local PC.

NOTE:  The Server and Standard installation processes require approximately 
100 MB of disk space during the installation process. The product software 
requires approximately 64 to 96 MB of RAM.

NOTE:  MATRIXX can be installed on a file server using a shared license manager. 
2
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1.3.1 Hardware Requirements

The following requirements apply to all computers that will run MATRIXX on 
Windows NT®, Windows 2000, Windows ME, Windows 98, or Windows 95:

■ IBM compatible 486 with a math coprocessor, or a Pentium processor.

■ Minimum 64 MB RAM, 96 MB recommended.

■ Approximately 230 MBs of disk space to complete a full MATRIXX 
installation. See Table 1-3, p.4 for details.

■ A video card that supports a minimum of 256 colors at 800 x 600 resolution; 
65,536 colors at 1024 x 768 resolution is recommended; True Color setting (16 
million) is supported. 

■ A CD-ROM drive for software installation or use of online books.

■ A 2-button Microsoft compatible mouse, with a 3-button Logitech mouse or 
equivalent preferred. 

1.3.2 Software Requirements

The following requirements apply to all computers that will run MATRIXX on 
Windows NT, Windows 2000, Windows ME, Windows 98, or Windows 95:

■ The MATRIXX software requires Windows NT version 4.0.

■ Supported installations include English, Japanese, and German.

■ If you want to link your own C code to Xmath or SystemBuild, you must 
purchase and install a copy of Microsoft Visual C++ 6.0 (Service Pack 3). For 
FORTRAN you must install a copy of DIGITAL Visual Fortran 6.0 for 
Windows NT.

■ Floating licenses require properly functioning TCP/IP networking which 
includes Winsock 1.1 or later.

NOTE:  You can change the number of colors for your display through 
Start→Settings→Control Panel→Display→Settings. 

NOTE:  DIGITAL Visual Fortran 5.0 for Windows NT (releases 408 through 333E) 
requires a patch for the linker before it will work properly. Contact Digital at 
www.digital.com/fortran to acquire the patch.
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■ Netscape 3.01 or later is required for MATRIXX Help. A version of Netscape is 
provided in the MATRIXX CD-ROM media.

1.3.3 Compatible Compilers and Operating System Versions

The MATRIXX software was developed and tested with the operating system and 
compiler versions listed in Table 1-2. These configurations are recommended for 
optimal compatibility.

Other operating system and compiler versions may be compatible with the 
MATRIXX software. For the latest information, check the Wind River Support 
page at www.windriver.com or contact Technical Support at 1-800-958-8885.

1.3.4 Minimum Disk Space Requirements

The minimum space requirements for the MATRIXX software on a Windows host 
are shown in Table 1-3. A complete installation requires approximately 230 MB of 
disk space during the MATRIXX installation process. This may be significantly 
larger for large disk partitions that use a FAT format.

Table 1-2 Verified Compilers

Compiler Windows NT 4.0, Windows 2000, Windows ME, Windows 98, or Windows 95

C or C++ Microsoft Visual C / C++ version 6.0, Service Pack 3

FORTRAN DIGITAL Visual Fortran version 6.0

! WARNING:  Other compilers may work in some cases, but are not supported. 
Wind River recommends against using unsupported compilers.

Table 1-3 Minimum Disk Space Requirements

Product Space Required

MATRIXX
License Manager
Netscape Navigator Stand-Alone (International)
Altia Design Animation (optional)
Altia FacePlate (optional)

135 MB
3 MB
17 MB
40 MB
35 MB

Full installation ~230 MB
4
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1.3.5 Requirements for Configuration Management Operation

The MATRIXX configuration management (CM) feature provides integration 
between SystemBuild™ and various configuration management tools. A user can 
store catalog items in files, and perform common version management operations 
from within the SystemBuild environment. Wind River currently supports the 
following CM tools:

■ ClearCase™ using both dynamic and snapshot views (version 3.2.1)

■ Merant PVCS™ (version 6.6)

■ Microsoft Visual SourceSafe™ (version 6.0)

Each of these tools has its own native working environment that must be installed 
and functioning before the tool can be used with SystemBuild.

1.3.6 Related Publications

Wind River provides a library of publications to support its products. Of special 
interest to the users of this publication are the installation guides, summarized as 
follows:

■ System Administrator’s Guide (Windows Version)

■ RealSim PC Controller Installation Guide (Windows Version)

■ RealSim AC-1000 Controller Installation Guide (Windows NT Version)

■ FLEXlm End User Manual (from GLOBEtrotter Software, Inc.)

All of the above and other MATRIXX documents are on the online documentation 
CD. For additional documentation, see the MATRIXX Help or the Wind River 
home page at http://www.windriver.com.

1.4 Installation Configurations

MATRIXX supports three installation types on Windows hosts: standard, server, 
and client. A PC can only support one of these installation types at a time for a 
given version of MATRIXX. If you want to change installation types for a version, 
you should uninstall and then reinstall that version. Multiple different versions of 
5
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MATRIXX software can be installed at one time on the same machine, possibly for 
different installation types. 

Figure 1-1 shows a typical client-server configuration.

1.4.1 Standard Installation

A standard installation installs the full set of MATRIXX software on the local 
Windows system. Typically, this type of installation is not visible to other 
machines on the network because it uses a local installation path not accessible to 
other systems. 

If you perform a standard install specifying the installation directory with a valid 
pathname in Uniform Naming Convention (UNC) format, for example:

\\computername\sharename\wind

then the installation will be visible to other users similar to a server installation. 

Figure 1-1 Typical Client-Server Configuration

ServerWindows NT or Windows 2000 Client

%ISIHOME%

license.dat

Windows 98 or Windows 95 Client Standalone System
6



1

1
Installation Overview and Platform Requirements
1.4.2 Server Installation

A server installation, which can only be run on Windows NT, installs the full set 
of MATRIXX software on the local Windows system similar to a standard 
installation. However, a server installation will, if necessary, automatically create 
a directory share with a user specified name for the local install directory, thus 
ensuring that the software is visible to other client systems on a network. A server 
installation can also accept a valid UNC format pathname for the installation 
directory path. 

1.4.3 Client Installation

A client installation (requiring only 5 KB of disk space) creates shortcuts to an 
existing server installation of MATRIXX and updates any Windows shared system 
files on the client required to run the MATRIXX software. It does not place any 
other software on the client system. During a client installation of MATRIXX, you 
will be asked to specify the network pathname of an existing MATRIXX server 
installation.

All client machines that will use MATRIXX software must be able to access the 
%ISIHOME% root directory on the server machine.

1.5 Licensing

MATRIXX uses FLEXlm® licensing utilities. For licensing information, see 
Licensing and Terminology on p.13, FLEXlm Licensing Tools on p.49, or the 
GLOBEtrotter® FLEXlm End User Manual on the MATRIXX documentation CD.
7
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1.6 Troubleshooting Resources

For troubleshooting tips, see Troubleshooting Your Installation, p.43. For 
troubleshooting assistance check the Wind River Support page at 
www.windriver.com, send email to Support@WindRiver.com, or contact Technical 
Support at 1-800-958-8885 or 1-800-872-4977.

To participate in an unmoderated online forum with other MATRIXX customers, 
you can subscribe to the MATRIXX  list server. Once you subscribe to the matrixx  
email list, you will automatically receive all messages sent to the list. To join the 
list server discussion group, send a message similar to the following:

To: listserv@windriver.com
Subject: Subscription

subscribe matrixx Your_Name

where Your_Name is a string for your name in any format (for example, MatrixX. 
User). 

To leave the discussion group, send the same message with unsubscribe replacing 
subscribe. (The list server records and responds to the sending email address.)
8
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Software Structure
This chapter describes installation planning options and MATRIXX 7.X directory 
structure.

2.1 Planning Options

Before starting the installation, you should make decisions about how and where 
you want to install MATRIXX tools. These issues must be addressed before you 
start the installation procedure detailed in Chapter 4.

MATRIXX 7.X must be installed in a different installation directory if you plan to 
keep versions prior to 7.X. The MATRIXX 7.X installation will not affect an older 
release of MATRIXX software as long as you do not use the same parent directory. 
You do not have to do any extra work to keep the older version of MATRIXX, 
which will still use its own license manager.

You can install a copy of MATRIXX on a local node using either floating or node-
locked licensing, or, you can use a file server (a shareable disk) and a shared 
license manager to install the MATRIXX software on a network server. The 
directory structure detailed here is of interest in both situations, as it handles 
multiple versions and multiple platforms.
9
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2.2 Directory Structure

The directory structure shown in Figure 2-1, p.11 shows the MATRIXX product 
structure, which enables you to manage the software in a central location in a 
network environment. This structure reduces the system administration issues of 
multiple installations for a given platform, because installation can be completed 
solely on a file server using a common license manager. Then a simple client 
installation on a networked node will let you access the file server installation. 
You can safely install multiple versions of MATRIXX 7.X into a common root 
installation directory (%ISIHOME%).

The commands used to invoke the MATRIXX suite of products can be found in the 
directory %ISIHOME%\bin.

NOTE:  All machines that will use MATRIXX software must be able to access the 
%ISIHOME% root directory. %ISIHOME% and installation_directory (referred to 
elsewhere in this document) are equivalent.
10
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Figure 2-1 MATRIXX Product Family Sample File Structure

(%ISIHOME%)

ISILM
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3

Licensing and Terminology
This chapter provides an overview of licensing and describes licensing-related 
terminology and tasks. MATRIXX 7.X includes a license daemon, lmgrd.exe which 
controls all Wind River product licenses. lmgrd.exe resides in the directory ISILM 
and must be running on your license server (or on all three if you have a 
redundant license server configuration). It does not have to be on the node where 
you install MATRIXX 7.X.

3.1 Licensing Overview

MATRIXX licensing includes the following features:

■ Floating and node-locked licenses

■ Redundant license servers (optional)

■ Flexible license checkout

3.1.1 Floating and Node-Locked Licenses

License configurations for counted floating licenses, node-locked licenses, and 
evaluation licenses are available on Windows NT, Windows 2000, Windows ME, 
Windows 98, and Windows 95 systems. To check out a floating license or counted 
node-locked licenses, a client system must be connected to the network and have 
13
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properly functioning TCP/IP software with Winsock support. Evaluation and 
uncounted node-locked licenses do not require that you have a running license 
server or network support.

Windows NT systems can function as network license servers for floating 
licenses; however, Windows ME, Windows 98, and Windows 95 systems are not 
supported as network license servers. Windows NT, Windows 2000, Windows 
ME, Windows 98, and Windows 95 systems can check out floating licenses from 
either a Windows NT or UNIX license server. To check out licenses from a 
network license server, a Windows system must reference a copy of the same 
license.dat file used by the network server, or it must reference a proxy license file 
(see 3.5, p.20).

3.1.2 Redundant License Servers

Redundant license servers are a set of three nodes designated to serve the same 
license file. If any node fails, the other two nodes will still be available to serve the 
licenses for MATRIXX. 

To support the redundant license server scheme, Wind River License 
Administration requires information for three Windows NT servers. This 
information includes the computername and hostid (that is, an Ethernet address) 
for each server. 

Wind River issues redundant license server keys once you provide the hostid of 
the three servers. At a minimum, you need to run the standalone license server 
installation program and start the license server on each machine. Follow the 
instructions described in Installing Redundant License Servers on p.34. 

Figure 3-1 shows a typical redundant license-server configuration.
14
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3.1.3 Flexible License Checkout

With MATRIXX 7.X licensing, a feature (product component) is checked out as 
you use it. A feature stays checked out until you exit that product component. For 
example, Xmath and SystemBuild modules are checked out when first used and 
stay checked out until you exit Xmath or SystemBuild. SystemBuild is checked 
out when you launch the Catalog Browser (by starting SystemBuild) and stays 
checked out until you exit SystemBuild. The flexible license checkout feature is 
also known as on-demand checkout.

3.2 Xmath Licensing Commands

Xmath has the following license-related commands:

■ LICENSECHECKOUT for checking out features for future use

Figure 3-1 Typical Redundant License Server Configuration

Windows NT ServerWindows NT Server

%ISIHOME%

license.dat

Windows NT Server One or More Client or Standalone Systems

%ISIHOME%

%ISIHOME%

license.dat

license.dat
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■ LICENSEUSER for displaying assigned licenses for any feature names 
specified

■ LICENSEINFO for displaying a license report for your site

■ LICENSEFILE for displaying the current license file search path

■ ISIREFNUM for identifying your Wind River reference number

All of these commands must be run from the Xmath Commands window.

3.2.1 LICENSECHECKOUT

LICENSECHECKOUT is an intrinsic command that checks out a license for the 
listed feature or features. Run LICENSEINFO to see a list of feature names. 
Features are specified as strings, and the name must be exactly as displayed by 
LICENSEINFO.

Although features are normally checked out on-demand, you can use 
LICENSECHECKOUT to reserve features for future use (for example, for a 
scheduled demo or presentation). They are checked in when you exit Xmath.

This command can be placed in a global or local startup.ms file to check out 
required features at startup. The syntax is as follows:

LICENSECHECKOUT feature1,feature2,...featureN

For example:

LICENSECHECKOUT "Xmath","Control","Sysid","Sysid2","sysbld","case"

3.2.2 LICENSEUSER

The LICENSEUSER utility displays assigned licenses for any feature names 
specified. The default feature is Xmath if no argument is specified. LICENSEUSER 
accepts feature names in string form. To see a list of the feature names for 
products you have purchased (for example, aca indicates AutoCode Ada), issue 
the LICENSEINFO command. The syntax for LICENSEUSER is as follows:

LICENSEUSER feature1,feature2,...featureN

Typical output is shown in Example 3-1.

Example 3-1 LICENSEUSER Output

licenseuser "xmath","aca"
16
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Users of Xmath:

Number of licenses purchased : 10
Number of unused licenses : 4

User Node Name Starting Time
muemura sampras Thu May 29 19:33:44 1999
lynch tribble Thu May 29 19:34:36 1999
sanjay castaway Sat May 31 19:01:04 1999
rpizzi castor Mon Jun 2 15:21:54 1999
dawn venus Wed Jun 4 11:05:06 1999
uma sampras Mon Jun 9 13:45:47 1999

Users of aca:
Number of licenses purchased : 4
Number of unused licenses : 2

User Node Name Starting Time
muemura sampras Thu May 29 19:56:44 1999
uma sampras Mon Jun 9 13:51:47 1999

3.2.3 LICENSEINFO

LICENSEINFO displays a license report for your site as shown in Example 3-2.

Example 3-2 LICENSEINFO License Report

licenseinfo

License File: C:\isi\isilm\license.dat
==========================================================================================
License Server Name: hardrock
License Server ID: 18000000
==========================================================================================
Module Name Feature Name Expiration Date Type Seats Licensed Node
Xmath Xmath 31-jan-2002 Floating 10
Control Design Module Control 31-jan-2002 Floating 10
SystemBuild sysbld 31-jan-2002 Floating 10
AutoCode C Single Processor acc 31-jan-2002 Node-Locked 4 80379b46
Model Reduction Module Modred 31-jan-2002 Floating 10
Interactive Animation Module Icdm 31-jan-2002 Floating 10
Robust Control Module Robust 31-jan-2002 Floating 10
RT/Fuzzy Module blk_fuz 31-jan-2002 Floating 10
AutoCode Ada Single Processor aca 31-jan-2002 Floating 10
DocumentIt docit 31-jan-2002 Node-Locked 4 80379b46
17
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3.2.4 LICENSEFILE

The LICENSEFILE command displays the current license file search path. The 
syntax and example output are as follows:

LICENSEFILE

License files searched by MATRIXx are as follows:

\\AGGIES\mx7x\isilm\license.dat
\\AGGIES\mx7x\isilm\tplic.dat

3.2.5 ISIREFNUM

The ISIREFNUM command displays the Wind River reference number (also 
known as your customer identification number). You should have this number 
ready if you plan to call Wind River customer support.

The syntax and example output are as follows:

ISIREFNUM

Your Wind River Reference Number is :
CUSTOMID99

3.3 Using Licensing

With concurrent licensing, you can have a different number of licenses for each 
module or application. An application or module is either available on a first-
come, first served basis, or node-locked to a given CPU. Some common uses of 
licensing are as follows:

■ To see all the features your site has purchased or to view the license 
expiration date, use the command LICENSEINFO.

■ To see who is using a given feature, or to see if a feature is available, use the 
LICENSEUSER command and specify the desired feature.

■ To see the current license file search path, use the command LICENSEFILE.

■ To reserve features for future use (for example, for a scheduled demo or 
presentation), use the LICENSECHECKOUT feature. 
18
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The initial distribution of licenses is determined at the time of the installation; to 
change licensing, your system administrator must get a new key from Wind River  
License Administration. To generate a new license file from this key, run the 
standalone license installation as described in 4.5 Updating a License File, p.39.

Wind River uses the FLEXlm license manager, a product of GLOBEtrotter 
Software, Inc. If you have license manager questions beyond the scope of this 
document, please see the FLEXlm End User Manual on the MATRIXX online 
documentation CD. For additional information about FLEXlm, see the 
GLOBEtrotter FAQ at www.globetrotter.com/flmfaq.htm. 

3.4 License Files

The set of licensed features available for checkout by a MATRIXX user are 
contained in one or more license files, each containing encrypted feature lines. 

The following default license files are used by the MATRIXX products:

■ %ISIHOME%\ISILM\license.dat — This primary license file contains feature 
lines for built-in MATRIXX features. The license.dat file is generated from 
Wind River provided authorization keys during the MATRIXX or standalone 
license manager installation procedures.

■ %ISIHOME%\ISILM\tplic.dat — This optional file contains license feature 
lines for third-party MATRIXX components. The encrypted feature lines in 
this file and the instructions for using the file will typically be provided by 
your third-party supplier. Multiple features from different third-party 
suppliers can be placed in this file. Typically, this file will also contain the 
same SERVER and DAEMON lines as license.dat. This file is not modified 
during a MATRIXX or license manager installation, nor is it deleted by 
uninstall procedures.

The search paths used to locate these license files are set in the environment 
variable %LM_LICENSE_FILE% by the MATRIXX product launching scripts. The 
aboveWind River license file paths are prepended to any existing definition of 
%LM_LICENSE_FILE%, thus allowing access to other MATRIXX or non-
MATRIXX products also licensed by a FLEXlm license manager.

Normally, the only things you can change in a license file are:

■ The hostname (not the hostid).
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■ The port number on the SERVER line. If this port number is already in use, 
the license daemon (lmgrd) will report Address In Use. The default port 
number used in MATRIXX 7.X license files is 27000, whereas for prior releases 
it was 5200. A valid number is any unused port number between 1025 and 
64000. The port number can be removed and the FLEXlm license manager 
will serve on any available FLEXlm reserved port in the range 27000-27009. 
For redundant license servers, however, you must use a fixed port number.

■ The path to the vendor daemon executable on the DAEMON line. (The 
vendor daemon is named mtxlmd.)

■ name=value pairs on a FEATURE line can be changed if name is lowercase.

Redundant license server files contain three SERVER lines. The first SERVER line 
defines the primary license server. The second and third lines define the 
secondary license servers.

3.5 Proxy License Files

If you are using a floating-license server, each licensing client needs a copy of the 
same license file used by the server. Alternatively, to avoid copying the license 
server file to each installation of MATRIXX, you can create a proxy license file in 
the ISILM directory of each MATRIXX installation. This approach can be used for 
both single and redundant license server configurations. The proxy license file 
(license.dat) can be constructed by taking the SERVER line or lines from the 
license server file and then adding a line containing USE_SERVER. For example, a 
proxy license file for a single server configuration would be as follows:

SERVER host1 17003456 27000
USE_SERVER

A proxy license file for a redundant server configuration, for example, would be:

SERVER host1 17003456 27002
SERVER host2 17004355 27002
SERVER host3 17007ea8 27002
USE_SERVER

Unless your server nodes are changed, you will not have to update the license file 
for each individual MATRIXX installation when the server license file is updated.
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Although a proxy license file is the preferred way to reference the actual license 
file used by a remote license server, you can also use a port@host definition for 
either of the environment variables LM_LICENSE_FILE or 
MTXLMD_LICENSE_FILE. port is the license file port number and host is the 
hostname, and both are taken from the SERVER line of the actual license file. 
MTXLMD_LICENSE_FILE is similar in use to LM_LICENSE_FILE, except that it is 
specific to the MATRIXX license manager daemon and overrides any concurrent 
definition of LM_LICENSE_FILE.

3.6 Compatibility

The MATRIXX 7.X license manager uses the vendor daemon mtxlmd (versus 
isilmd in releases prior to 6.X) and the default port number 27000 (versus 5200 in 
releases prior to 6.X). The MATRIXX 7.X license manager  is compatible with the 
release 6.X software and can supersede the earlier version.

3.7 Licensing Requirements

If you are a new user, your software is shipped with an evaluation key. Note that 
the key clearly states the expiration date. You can install the evaluation license, 
and then later regenerate the license file for a standard installation (as described 
in Updating a License File, p.39). In order to obtain a standard license, you must 
provide the computername and hostid for each license server machine. 

NOTE:  Because of the addition of new features and new license manager 
functionality, license keys issued prior to MATRIXX 6.X cannot be used to 
regenerate a license file for release 7.X. 
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3.7.1 Finding the Host ID

FLEXlm uses different machine identifications for different machine architectures. 
An Ethernet address is the preferred “host ID” for a Windows platform. An 
Ethernet address is a 6-byte quantity, with each byte specified as two hexadecimal 
digits. Specify all 12 hex digits when using an Ethernet address as a host ID.

The program %ISIHOME%\ISILM\lmhostid will print the Ethernet host ID that 
FLEXlm expects to use on any given machine. For floating licenses, you must 
provide an Ethernet address. For node-locked licenses, an Ethernet address is 
preferred, but a disk volume serial number for drive C: can be used. A disk 
volume serial number is an 8-character string with the dash omitted. Table 3-1 
lists alternate methods to obtain the required host ID.

3.7.2 Finding the Computer Name

The Computer Name is defined at the time Windows is installed. To see the 
Computer Name, select Start→Settings→Control Panel→Network. The Identification 
tab appears; the first entry is the Computer Name. 

3.7.3 Contacting Wind River License Administration

Contact License Administration in one of the following ways:

■ Complete a Key Request Form (included with your software) and fax it to 
408-542-1953.

■ Send email with the information asked for in the Key Request Form to 
license@windriver.com.

Table 3-1 Obtaining the Host ID on Different Platforms

Platform Host ID DOS Shell Command Example

Windows NT Ethernet address ipconfig /all

(Physical address)

08002be5a721 

Windows ME/98 Ethernet address winipcfg /all

(Adapter address)

08002be5a722 

Windows NT/
ME/98

Disk volume serial 
number for C: drive

c:\vol 1F68-5D8A

(disregard dash)
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■ Call 1-800-545-0463 (options 8 and 5)  between 9 a.m. and 5 p.m. Pacific Time, 
Monday through Friday, and follow the voice mail directions which route you 
to the License Key Request administrator. 

Wind River supplies the authorization key(s) and checksum(s) used to generate 
the license file, which enables you to use the packages and modules you 
purchased. An authorization key or checksum is an alphanumeric string that does 
not contain the numbers 0, 1 or 5 to avoid confusion with the uppercase letters O, 
I, and S.
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Installation and Related Tasks
This chapter describes how to install MATRIXX software, including any optional 
components such as Altia Design animation, and perform related tasks.

4.1 MATRIXX 7.X Installation

This section provides a detailed description of how to install MATRIXX 7.X 
software on a client, server, or standalone PC.

Requirements

■ Your system must meet the hardware and software requirements for your 
platform specified in Chapter 1, Installation Overview and Platform 
Requirements.

■ A server installation must be on a Windows 2000 or Windows NT 4.0 system. 

■ Floating licenses require properly functioning TCP/IP networking which 
includes Winsock version 1.1 or later.

Privileges

For a Windows NT installation, you must have Administrator privileges.
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Installation Procedure

Before running the installation program, you will need the Wind River reference 
number, authorization key, and checksum. 

1. Place the MATRIXX 7.X CD in the CD-ROM drive. 

2. Use the Windows Explorer to find the setup.exe file in the MATRIXx directory 
and launch it.

3. After the Welcome and End-User License Agreement screens (not shown), the 
following dialog prompts you for the location of your installation directory.

4. Setup defaults to c:\wind but you can use the Browse button to select any 
other local (or server) location.

NOTE:  Before beginning the installation make sure you exit from any other 
software and stop all virus scan software.
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5. After you click Next, the Setup Type dialog prompts you to select Client, Server, 
or Standard (the default). Select the appropriate type as described in 1.4, p.5.

a. If you select Client, you will be prompted for the path to an existing 
MATRIXX server installation:
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b. If you select Server, you will be prompted for the Sharename for the 
installation directory unless you entered a universal naming convention 
(UNC) pathname as the install location:

6. Setup copies the MATRIXX product files and updates any shared 
components. The TradeWinds service installation is launched automatically 
at the completion of the MATRIXX product installation. If you see the 
following message:

Unable to locate TradeWinds InstallShield Setup file. Please check your
distribution.

see 4.2.6 Installing the TradeWinds Service for instructions.

The license manager installation is automatically launched.
28



4

4
Installation and Related Tasks
License Installation

7. If Setup finds an existing License Manager (ISILM) installation in the 
Windows registry, you see the following prompt about your registry entries:

If you click Yes, the new license file generated during this installation 
procedure supersedes the one currently registered in the registry. If you click 
No, the new license file generated during this procedure will only be used by 
the products installed as part of this current installation.

8. The Wind River License Manager (ISILM) installation asks you whether you 
want to generate a new license file (license.dat):

a. If you click No, go to Step 9, p.31.

b. If you click Yes, the installation prompts you for your reference number, 
authorization key, and checksum:

NOTE:  If you don’t already have a MATRIXX 7.X license file, click Yes to generate 
one. If you intend to access a floating license provided by another host, click No to 
avoid generating a new license. Then when the installation is complete, use a text 
editor to create a proxy license file named license.dat in the 
installation_directory\ISILM folder as described in 3.5 Proxy License Files, p.20, 
Proxy License Files.
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The MATRIXX 7.X software has an option for running backup license 
servers called redundant servers. If you have purchased the redundant 
server option, you will also be prompted to enter the hostnames of the 
additional license servers.

After you enter valid data, the License File dialog (not shown) displays 
the generated license file. 

c. On Windows NT systems, you are prompted to start the license server, 
unless you have an Evaluation license:

NOTE:  The license server is not required for an Evaluation license. For other 
licenses, the license server can always be started later from the MATRIXX License 
Server icon in the Control Panel.
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9. Upon completion, you can select to display the README file (an ASCII 
version of the release notes that are also available in the MATRIXX Help) or 
exit the installation.

10. If you are installing redundant license servers, complete the procedure 
described in Installing Redundant License Servers on p.34.

11. To start Xmath 7.X, select Start→Programs→MATRIXX→Xmath, or enter either 
of the following from the Command Prompt:

installation_directory \bin\xmath

-or-

installation_directory \bin\xmath -v version

where version is the installation version that you just installed, or one of the 
versions in installation_directory\bin.

12. (Optional) Once you have verified that Xmath starts successfully, go to 
Installing Other Components on p.32, if you plan to use Altia Design or Altia 
FacePlate.

13. If you do not already have Netscape installed, use the Windows Explorer to 
select the Netscape setup file (setup.exe) from the Netscape directory on the 
CD. Netscape 3.01 or later is required to support MATRIXX Help. After 
installing Netscape, to ensure that it is configured properly, invoke it and 
answer any dialog prompts before using it with MATRIXX.

NOTE:  In most cases rebooting is not necessary, but Setup prompts you to reboot 
if required. If you have just completed a server installation, be sure to set your 
desired access permissions for the ISIHOME directory share.
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4.2 Installing Other Components

This section describes the installation procedures for installing optional MATRIXX 
components.

4.2.1 Installing Altia Design Animation

Since the Altia Design software uses the Wind River license manager, you must 
have either MATRIXX or the standalone license manager installed. 

To install Altia Design animation software, follow these steps:

1. Verify that the MATRIXX CD is in your CD-ROM drive.

2. Use the Windows Explorer to find the setup.exe file in the Altia\Design 
directory, and launch it.

3. When the installation dialog prompts you for the installation directory, 
specify ISIHOME where ISIHOME is your existing MATRIXX installation 
directory.

4.2.2 Installing Altia FacePlate

Since the Altia FacePlate software uses the Wind River license manager, you must 
have either MATRIXX or the standalone license manager installed. 

To install Altia FacePlate software, follow these steps:

1. Verify that the MATRIXX CD is in your CD-ROM drive.

2. Use the Windows Explorer to find the setup.exe file in the Altia\Face 
directory, and launch it.

3. When the installation dialog prompts you for the installation directory, 
specify ISIHOME where ISIHOME is your existing MATRIXX installation 
directory.

NOTE:  If you choose not to install within your current ISIHOME directory, you 
must edit the Altia code words file after installation is complete to identify the path 
of the Wind River license manager file (license.dat). Select Start→Programs→Altia 
Design→Codeword File and specify the path to the Wind River license file.
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4.2.3 Installing RealSim

To install RealSim, see the RealSim PC Controller Installation Guide (Windows 
Version) or the RealSim AC-1000 Controller Installation Guide (Windows NT Version). 
Both of these installation guides are available in printed form and are on the 
online documentation CD.

4.2.4 Installing the Standalone License Manager

The standalone license manager installation, which populates only the ISILM 
subdirectory tree, is a subset of the full MATRIXX installation. It can be used to 
provide support for other standalone product installations such as Altia 
animation or RealSim, which require MATRIXX licensing but may not need the 
full MATRIXX product set to function. In addition, it can provide the required 
licensing installation on single or redundant license servers.

Installation Procedure

Before running the installation program, you will need the Wind River reference 
number, authorization key, and checksum. 

1. Place the MATRIXX 7.X CD in the CD-ROM drive. 

2. Use the Windows Explorer to find the setup.exe file in the ISILM directory 
and launch it.

3. Select the Install License Manager setup type and follow the dialog prompts to 
complete the installation.

4. Each installation of MATRIXX installed in a separate location can access the 
license server via the proxy license file described in 3.5 Proxy License Files, 
p.20, Proxy License Files.

NOTE:  If you choose not to install within your current ISIHOME directory, you 
must edit the Altia code words file after installation is complete to identify the path 
of the Wind Riverlicense manager file (license.dat). Select Start→Programs→Altia 
FacePlate→Codeword File and specify the path to the Wind River license file.
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4.2.5 Installing Redundant License Servers

At a minimum, installing redundant license servers requires the installation of 
standalone license manager software and starting the license manager daemon on 
two other nodes in addition to the primary license server. Special license keys are 
required for a redundant license server configuration. 

To install a typical redundant license server configuration, follow these steps:

1. Perform a standalone license manager installation on the primary license 
server (see 4.2.4 Installing the Standalone License Manager, p.33) or a complete 
MATRIXX installation if you want this machine to also serve the MATRIXX 
application files (see 4.1 MATRIXX 7.X Installation, p.25). Either procedure 
requires generating a license file and starting the license daemon.

2. On each of two secondary license servers, run either the standalone license 
manager installation (see 4.2.4 Installing the Standalone License Manager, p.33) 
or a complete MATRIXX installation (if you want to replicate all the MATRIXX 
files), and then start the license daemon on each machine.

3. Each separate installation of MATRIXX can access the license server with a 
proxy license file as described in 3.5 Proxy License Files, p.20.

4.2.6 Installing the TradeWinds Service

This section describes how to install the TradeWinds service on Windows NT and 
Windows 2000, and implement this pseudo-service on Windows ME, Windows 
98, and Windows 95. The TradeWinds service combines the following 
functionalities:

■ A CORBA (Common Object Request Broker Architecture) naming service 
(full implementation)

■ A session manager

■ A portmapper (local lookup service)

This service (on Windows NT and Windows 2000) or pseudo-service (on  
Windows ME, Windows 98, and Windows 95) is installed by a separate 

NOTE:  Rather than generating the license file on each secondary license server, 
copy license.dat from the ISILM directory of the primary server to the ISILM 
directory of each secondary server before starting the license daemons. Edit the 
DAEMON line of each secondary copy of the license.dat file to point to the daemon 
path that contains mtxlmd.exe for that server.
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InstallShield setup.exe file which is called from the MATRIXX InstallShield setup 
program.  This separate TradeWinds setup is launched, assuming the distribution 
media structure at the root of the CD-ROM is maintained. If this is not done (for 
example, if you only copy files in the MATRIXX installation folder to a separate 
location and invoke the setup program from there), the following warning 
message during the MATRIXX installation appears (at the end of the MATRIXX 
installation and just prior to the installation of the license manager):

Unable to locate Tradewinds Installshield setup file. Please check your
distribution.

If this message appears, just click OK button to proceed with the License Manager 
installation and install the TradeWinds service/pseudo-service separately as 
described below.

1. Locate the setup.exe file in the TradeWinds directory of your installation 
media.

2. Double click on the setup.exe program to launch the setup.

No other information is required.  

This service is configured so that it is automatically started on system startup.  
The files associated with this service reside in the C:\Program 
Files\windriver\tradewinds directory.  The port numbers used by the service are 
contained in the tw.cfg file. 

Setting the computername

In order for the TradeWinds daemon to run, you must set the computername by 
adding the following line to your c:\autoexec.bat file on Windows ME, 
Windows 498, or Windows 95:

set COMPUTERNAME=your_computer_name

where your_computer_name is the computer name specified in your network 
configuration properties dialog in the Control Panel.
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Changing port numbers

The following procedure describes the method for changing the port numbers 
used by the TradeWinds service:

On Windows NT or Windows 2000:

● To stop the service, from Settings→Control Panel→Services scroll down to 
the TradeWinds service, select TradeWinds and click Stop.

● Once the service has been stopped, edit the tw.cfg file in the C:\Program 
Files\windriver\tradewinds directory changing the traderservice.port 
entry as necessary.

● To start the service, from Settings→Control Panel→Services scroll down to 
the TradeWinds service, select TradeWinds, and click Start.

On  Windows ME, Windows 98, or Windows 95:

● To stop the service, press Ctrl-Alt-Delete to bring up the Task Manager.

● Select the TradeWind.exe process and click End Task.

◆ Once the service has been stopped, edit the tw.cfg file in the 
C:\Program Files\windriver\tradewinds directory changing the 
traderservice.port entry as necessary.

◆ Log out. Once you log in again the TradeWind.exe process starts 
automatically.
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4.3 Using Online Documentation

MATRIXX online documentation is provided in PDF format on a separate CD. The 
documents can be accessed from the MATRIXX online documentation CD or 
copied to any location on your local system.

Viewing and Searching PDF Files

To view MATRIXX online documentation, launch Adobe Acrobat Reader with 
Search (version 3.01 or higher), and then open the welcome.pdf file. The 
welcome.pdf file is a table of contents for PDF documentation on the CD. Click 
any document title to open that document.

If you do not have Acrobat on your system, see Installing Acrobat Reader with 
Search.

Using Acrobat Reader

Each document has a “bookmarks” pane displayed on the left. 

All bookmarks and blue text are hypertext links. To follow a link, be sure the hand 
tool is selected; then click the bookmark or blue text. 

Use the following Acrobat toolbar buttons for browsing and navigation:

Select Help → Reader Guide for a detailed description of all Acrobat capabilities.

Bookmarks can contain the following links:

■ Welcome: Link to the Welcome screen.

■ Document Title: Link to the cover of the current document.

■ Contents: Link to the Table of Contents for the current document.

Hand tool: click a link to jump there; click and
drag to move page in window

Click to enlarge
Control-click to reduce

First
page

Go to
next view

Last
page

Previous
page

Next
page

Go to
previous view

Select
text
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■ Chapter and Section Bookmarks: Links to chapters and sections in the 
document. 

■ A right-pointing triangle in front of a bookmark means there are sub-
bookmarks; click the triangle to expand to lower-level bookmarks.

■ Index: Link to the Index of the current document if one exists.

Pasting Text into Other Applications

To copy examples or text from a PDF document into an application, first click 
Tools → Select Text, or click the abc button. Select the text, and then use the usual 
technique on your platform to copy and paste the text into the target application.

Find and Search in PDF

The Acrobat Reader Find feature locates words or word phrases in the current 
PDF document. 

To use Find, click the plain binoculars on the toolbar, or select Tools → Find.

To make a full-text search over all documents on the CD, use the Search tool. Click 
the binoculars overlaid on a document on the toolbar, or select Tools → Search. In 
the Search dialog, enter the word or phrase you want to find, select options as 
desired, and then click Search. Search displays a Search Results List dialog of 
documents containing the term. Click any document in the list to open it. All 
instances of the term on the first page where it occurs are highlighted.

To find the next or previous occurrence, click the Next or Previous hit buttons on the 
Acrobat toolbar. To return to the Search Results List dialog, click the Search Results
List button.

The Search command includes powerful features for expanding a search using 
automatic word-stemming, a thesaurus to find synonyms, and a “sounds like” 

Find a word in the
current document

Search dialog

Search Results List Next hit

Previous hit
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feature. You can also use wild cards in terms, control case matching, and include 
Boolean connectives.

For further details on Search, select Help → Plug-In Help → Using Acrobat Search to 
read the online guide.

4.4 Installing Acrobat Reader with Search

If you have an old version of Acrobat Reader, uninstall it before installing the new 
version. 

To install from the Windows Explorer, find the 
Acroread\Win\Rdr_srch\32bit\Setup.exe file on the CD and launch it.

To install from a Windows Command Prompt, type the following command, 
substituting your drive letter for d.

d:\Acroread\Win\Rdr_srch\32bit\Setup.exe

The online books can be read directly from the CD or copied to your local system. 

4.5 Updating a License File

To update a license file, run the standalone license manager installation as 
described in 4.2.4, p.33 and select the Update License File setup type.

NOTE:  If Acrobat is installed, don’t copy the Acroread  folder from the CD to 
your local system, or you may overwrite your installation.
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4.6 Using MATRIX X Help

MATRIXX 7.X provides a hypertext markup language (HTML) help system. 
MATRIXX Help is a self-contained system with multiple hypertext links from one 
component to another. This help system, augmented by online and printed 
manuals, covers most MATRIXX topics except for installation. 

MATRIXX Help runs with Netscape 4.03 or greater. The MATRIXX CD includes a 
self-extracting executable of the latest supported version.

Printing Files

To print a Help topic, go to the Topics Hierarchy, and select a topic (for example, 
Dynamic Systems→Control Design) and then right click and hold. A Netscape 
window displays with one of the options saying Open Frame in New Window. Once 
the Help topic is in the new window, select Print (or any other standard Netscape 
capability).

Additional Netscape Information

For more information on Netscape products, see Netscape’s home page at:
http://home.netscape.com.

4.7 Installation-Related Tasks

Table 4-1 lists installation-related tasks with corresponding page references.

Table 4-1 Installation Tasks

To learn about... Go to...

Setting Up a User Environment for Printing p.41

Running Multiple MATRIXX Releases p.41

Recording Your Wind River Reference Number p.41
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4.7.1 Setting Up a User Environment for Printing

The environment variable %XMATH_PRINT% defines the printer for MATRIXX. 
The following are sample definitions for %XMATH_PRINT%, where \\pluto\hp4 
should be replaced by your printer.

4.7.2 Running Multiple MATRIX X Releases

You can install multiple releases of MATRIXX 7.X or later under a common 
directory. If you have multiple releases installed, the following command lets you 
run a selected version:

installation_directory \bin\ command_name -v version

where command_name is xmath, sbsim, autostar, ia, encrypt, mtxdemo, or mtxhelp, 
and version is one of the versions in installation_directory\bin. The version string 
appears as a suffix on the launching scripts.

4.7.3 Recording Your Wind River Reference Number

To help us provide rapid support when you call Wind River, the installation 
procedure prompts you for the 10-character reference number while installing 
MATRIXX 7.X or the license manager. Your reference number is stored in the file 

Moving the ISIHOME Directory Tree to Another Directory p.42

Configuration Management Installation Tasks p.42

Troubleshooting Your Installation p.43

Table 4-1 Installation Tasks (Continued)

To learn about... Go to...

Windows 2000 or NT: Set the following using the Control Panel system 
applet:

set XMATH_PRINT=%MATRIXX%\xmath\bin\xmprint
\\pluto\hp4

Windows ME, 98, or 
95:

Set the following in your AUTOEXEC.BAT file:

set XMATH_PRINT=%%MATRIXX%%\xmath\bin\xmprint
\\pluto\hp4
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%ISIHOME%\ISILM\config.txt. If you do not have a reference number, you can 
obtain one from Wind River License Administration when you request your 
Authorization Key and enter it into the first line of the config.txt file as follows:

REFERENCE NUMBER:10_character_string

You can use the Xmath ISIREFNUM command to display the reference number. 

4.7.4 Moving the ISIHOME Directory Tree to Another Directory

If you want to move the ISIHOME directory tree to another directory after 
installing MATRIXX 7.X, the preferred method is as follows:

1. Save the license.dat file (if required). 

2. Uninstall the MATRIXX software after stopping the license daemon.

3. Reinstall MATRIXX in the new directory location.

4. Copy the license.dat file to the new directory location.

5. Restart the license daemon.

4.7.5 Configuration Management Installation Tasks

The MATRIXX configuration management (CM) utility provides integration 
between SystemBuild and the ClearCase, Merant PVCS, and Microsoft Visual 
SourceSafe CM tools. Before using this utility, you must install the CM license key. 
For information about obtaining and installing license features, see Chapter 3, 
Licensing and Terminology.

The ClearCase, Merant PVCS, and Microsoft Visual SourceSafe CM tools all have 
their own native working environment that must be installed and functioning 
before the CM tool can be used with SystemBuild. SystemBuild uses the Microsoft 
Common Source Code Control interface to connect with these tools. When one of 
these CM tools is installed, entries are written to the Windows registry. These 
registry entries allow SystemBuild to connect to the CM tool. 

When you connect to CM, you must set your working directory to the working 
directory for the selected project. The CM tool supports working with one project 
at a time (there is a 1:1 relationship between the working directory and a project).
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4.7.6 Troubleshooting Your Installation

The following sections provide some troubleshooting tips.

Virus Scanners and Utility Software

It is important that virus scanner software be disabled before installing MATRIXX. 
Virus scanners and some utility software can interfere with the ability of the 
InstallShield program to run external programs during installation. External 
programs are used during install to set the installation path in MATRIXX 
launching scripts and to generate the license file. Symptoms of external program 
failure are that the MATRIXX launching scripts do not have the correct installation 
path set in environment variables such as %ISIHOME%, thus causing Xmath and 
other programs to fail to launch. If license file generation fails during an install, 
Xmath may report a license file error when trying to run.

It is possible to run the external programs from the Command Prompt after an 
install to fix these problems without performing a complete reinstall. You can 
invoke each of the two programs listed below without providing parameters to 
get a usage message that describes the required Command Prompt arguments.

■ To generate a new license file from the Command Prompt window, change 
directory to %ISIHOME%\ISILM and run the license file generator 
engine.exe. You should use the -nolog parameter when generating the license 
from the Command Prompt. This program replaces the license.dat file in the 
%ISIHOME%\ISILM directory.

■ To reset the installation path in the MATRIXX launching scripts, run the Perl 
program moveinstall.pl. You can invoke this program as follows to get its 
usage description:

%MATRIXX%\perl\perl.exe %MATRIXX%\version\moveinstall.pl

where %MATRIXX% is the MATRIXX product subdirectory as shown in 
Figure 2-1, p.11.

Temp Directory Usage During Install

InstallShield uses the Windows TEMP folder during installations. It is therefore 
important that sufficient disk space exist on the disk drive containing TEMP 
(which may be different from the drive where you are installing MATRIXX). An 
installation can fail when there is insufficient disk space on the TEMP drive. On 
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rare occasions, an InstallShield install can fail due to remnants in the TEMP folder 
of a previously aborted install. You can avoid this problem by clearing the 
contents of the TEMP folder.

Product Icons (Windows NT and Windows 98)

If you are upgrading to MATRIXX 7.X from from MATRIXX 5.X or earlier, you 
may see the old shortcut icons appearing in the Start→Programs→MATRIXx 7X.X 
menu after product installation. This is due to a Microsoft identified operating 
system problem in Windows NT 4.0 and Windows 98 (Microsoft knowledge base 
article ID: Q133733). This problem is caused by the operating system failing to 
update the ShellIconCache file in the Windows folder. To resolve this problem on 
Windows NT or Windows 98, Microsoft recommends the following steps to force 
a refresh of the ShellIconCache file: 

1. In Control Panel, double-click Display. 

2. Click the Appearance tab.

3. In the Item box, click Icon.

4. Increase the icon size by one unit.

5. Click Apply.

6. Decrease the icon size by one unit, and then click OK.

Windows NT License Servers

On Windows NT, the license server must be started unless you are using an 
Evaluation license or are using another network node as a floating license server. 
When the license server is properly started, the lmgrd and mtxlmd processes 
should appear in the process list of the Windows NT task manager. You can use 
the MATRIXX License Server applet in the Windows NT Control Panel to start or 
stop the license server or to check its status. You can also check the contents of the 
license server diagnostic log file, installation_directory\ISILM\debug.log, to see if 
the license server is running correctly. If the license server is running and you 
wish to use a different copy of the license.dat file, you should stop the license 
server first, copy the new license.dat file and then restart the license server.

If you try to perform one of the following licensing tasks and receive an error 
message, you may be able to correct it by identifying the cause as described in 
Table 4-2.
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Environment Space on Windows 98

On Windows 98, if you try to launch Xmath and it does not come up, this usually 
means that you are out of environment space. This can happen if you have other 
software installed that uses up most of your default environment space. To 
confirm this, you can right-click on the Xmath shortcut and uncheck the Close on
exit option under the Program tab. The Xmath shortcut is usually located in the file:

Windows\Start Menu\Programs\MATRIXx 7X.X\Xmath

If you then see the message:

Out of environment space

in the remaining Command Prompt window after trying to launch Xmath, you will 
have to increase the environment size. You can increase the environment size by 
setting the Initial environment to 4096 under the Memory tab of the above Xmath 
shortcut. 

If you must have an even larger environment space or if you need to increase 
your environment space globally, you will have to add a SHELL line to your 
config.sys file. For an environment space of 8192 bytes, this SHELL line is as 
follows:

SHELL=c:\windows\command.com /p /e:8192

Table 4-2 Error Message Definitions

Command Error Message or Problem Cause or Remedy

lmdiag lmdiag reports that the hostid is 
correct, but the license daemon 
has not been started.

Kill all lmgrd processes started for the 
license.dat file (they are trying to use 
the same TCP/IP port) and start a new 
lmgrd process.

lmreread -c license_file

You cannot use lmreread to 
change server node names or port 
numbers.

You have changed the server name or 
port number. Kill the old daemon, then 
restart the license daemon.
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4.8 Uninstalling MATRIX X 7.X

The following summarizes the items to consider when performing a complete 
uninstall of MATRIXX software:

■ All MATRIXX and Altia software should be removed by using the Add/Remove
Programs icon in the Control Panel. 

■ If you want to uninstall the optional Altia Design animation software and it is 
installed under the MATRIXX installation directory, then Wind River 
recommends that you uninstall it before removing MATRIXX. 

■ On Windows 2000/NT only, if you want to uninstall the MATRIXX License 
Server, then Wind River recommends that you uninstall it before removing 
MATRIXX.

■ On Windows 2000/NT only, if you want to uninstall a server installation of 
the MATRIXX 7.X software, you should first remove any file shares associated 
with the MATRIXX installation directory.

Since Windows 2000/NT platforms support the MATRIXX license server, you will 
need to take the following steps to remove the license server and the MATRIXX 
software:

1. Stop and remove the MATRIXX License Server service from your machine by 
taking one of the following steps:

● Select Control Panel→MATRIXX License Server. On the Control tab dialog, 
click Stop (if a failure is reported, the server may already be stopped). On 
the Setup tab click Remove.
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● Alternatively, invoke %ISIHOME%\ISILM\stopsrv.exe from a Command
Prompt window to shut down the license server and remove it from 
Windows NT.

2. Remove the MATRIXX License Server and MATRIXX version 7.X software by 
taking these steps:

a. Use Control Panel→Add/Remove Programs to remove the MATRIXX License 
Server.

b. Use Control Panel→Add/Remove Programs to remove the MATRIXX 7.X 
software.

3. Close the Control Panel, and then remove the MATRIXX License Server icon 
from the Control Panel by deleting the mtxlm.cpl file from the Windows NT 
system32 directory. This file must be removed manually because 
Windows NT will not let you remove it during the uninstall process.

4. (Windows NT or Windows 2000 only) Remove the TradeWinds service as 
follows:

a. From Control Panel→Services, select TradeWinds from the Services dialog 
and click Stop.

b. From Control Panel→Add/Remove Programs, select TradeWinds from the Add/
Remove Programs Properties dialog and click Add/Remove.

! CAUTION:  Be certain that no other Wind River products using TradeWinds 
service are installed before removing it.
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5

FLEXlm Licensing Tools
This chapter describes the FLEXlm utilities. This includes explaining how to 
troubleshoot common license manager problems and describes messages from 
the daemon log file. For additional licensing documentation, see the FLEXlm End 
User Manual from GLOBEtrotter Software, Inc. on the MATRIXX documentation 
CD.

5.1 FLEXlm Utilities

MATRIXX 7.X uses FLEXlm for its license server. FLEXlm provides the following 
OS utilities to help manage the licensing activities on the network:

lmstat Helps you monitor the status of all network licensing 
activities.

lmdiag Lets you diagnose problems when you cannot check 
out a license.

lmgrd Starts the license daemon.

lmhostid Reports the host ID of a system.

lmreread Causes the license daemon to reread the license file and 
start any new vendor daemons.

lmver Reports the FLEXlm version of a library or a binary.
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5.1.1 lmgrd

lmgrd is the main daemon program for FLEXlm. When you invoke lmgrd, it looks 
for the license file. The license file contains information about vendors and 
features. 

Syntax is:

lmgrd [ -c license_file ] [ -t timeout ][ -s interval ] [ -b ]
[-l logfile ]

where:

5.1.2 lmstat

The lmstat utility helps you monitor the status of all network licensing activities, 
including:

■ Which daemons are running

■ Users of individual features

■ Users of features served by a specific daemon

Syntax is:

lmstat [-a] [-S [ DAEMON]] [-f [ feature ]] [-s [ server_name ]]
[-t value ] [-c license_file ][-A] [-l [ regular expression ]

where:

-app Is required for Windows NT systems. 

-c license_file Uses the specified license file. 

 -t timeout Sets a timeout interval, in seconds, during which 
redundant daemons must complete their connections to 
each other. The default value is 10 seconds. A larger 
value may be desirable if the daemons are being run on 
busy systems or a heavily loaded network.

 -s interval Specifies the logfile timestamp interval, in minutes. The 
default is 360 minutes.

-l logfile Specifies the pathname to the log file. If this option is 
not specified, the log will be sent to standard output.

-v Prints the lmgrd version number.
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5.1.3 lmreread

The lmreread utility causes the license daemon to reread the license file and start 
any new vendor daemons that have been added. Additionally, all pre-existing 
daemons will be signaled to reread the license file for changes in feature licensing 
information. Syntax is:

lmreread [-c license_file ]

5.1.4 lmhostid

The lmhostid utility reports the host ID of a system. Syntax is:

lmhostid [ether | long]

The output of this command appears as follows:

lmhostid - Copyright (C) 1989-2000, Globetrotter Software, Inc. The FLEXlm
host ID of this machine is "69021c89"

The ether option causes lmhostid to print the Ethernet address on 
Hewlett-Packard (HP) systems. On HP systems the long option prints the value of 

-a Displays everything.

-A Lists all active licenses.

-c license_file Uses license_file.

-S [DAEMON] Lists all users of the specified daemon’s 
features.

-f [feature_name] Lists users of the specified feature(s).

-l [regular expression] Lists users of matching license(s).

-s [server_name] Displays status of server node(s).

-t value Sets lmstat time-out to value.

NOTE:  If you use the -c option, the license file specified will be read by lmreread, 
not by lmgrd; lmgrd rereads the file it read originally. Also, lmreread cannot be 
used to change server node names or port numbers. Vendor daemons will not 
reread their option files as a result of lmreread.
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the HP ID module. These options are only available in FLEXlm v2.21 or later. The 
default is long for FLEXlm v2.21 or earlier, and ether for FLEXlm v2.4 or later.

5.1.5 lmdiag

lmdiag allows you to diagnose problems when you cannot check out a license.

Usage is: 

lmdiag [-c license_file ] [-n] [ feature ]

where -c license_file path to file to diagnose. -n run in noninteractive mode; lmdiag 
will not prompt for any input in this mode. In this mode, extended connection 
diagnostics are not available. feature diagnose this feature only. 

If no feature is specified, lmdiag will operate on all features in the license file(s) in 
your path. lmdiag will first print information about the license, then attempt to 
check out each license. If the checkout succeeds, lmdiag will indicate this. If the 
checkout fails, lmdiag will give you the reason for the failure. If the checkout fails 
because lmdiag cannot connect to the license server, then you have the option of 
running “extended connection diagnostics.” 

These extended diagnostics attempt to connect to each port on the license server 
node, and can detect if the port number in the license file is incorrect. lmdiag will 
indicate each port number that is listening, and if it is an lmdiag process, lmdiag 
will indicate this as well. If lmdiag finds the vendor daemon for the feature being 
tested, then it will indicate the correct port number for the license file to correct 
the problem. 

5.1.6 lmver

lmver reports the FLEXlm version of a library in binary. Usage is:

lmver [ filename ]

where filename can be mtxlmd.exe or lmgrd.exe.
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5.2 Resolving Problems

This section offers some general debugging tips, and discusses information you 
should gather before contacting support. 5.3, p.54 lists common license manager 
problems users have encountered before.

5.2.1 General Debugging Tips

The following are tips for debugging:

■ Examine the %ISIHOME%\ISILM\debug.log file.

■ If you cannot check out a feature, run:

%ISIHOME%\ISILM\lmdiag -c %ISIHOME%\ISILM\license.dat

■ If the license daemon appears to have started correctly (which you should be 
able to determine from the isi.log file), try running lmstat to see if that 
program has the same problem as your application.

lmstat -a -c %ISIHOME%\ISILM\license.dat

5.2.2 Support Issues

When you make a support call, please be prepared to answer the following 
questions:

■ What kind of machine is your license daemon running on? What version of 
the operating system is the application running on?

■ What version of FLEXlm does the program use? Use the following command 
on your mtxlmd vendor daemon and application:

%ISIHOME%\ISILM\lmver %ISIHOME%\ISILM\mtxlmd.exe

■ What error or warning messages appear in the log file? Did the daemon start 
correctly? Look for a message such as: 

server xyz started for: feature1 feature2 .

■ What is the output from running lmstat -a?

■ Are you running other products which are also licensed by FLEXlm? Wind 
River does not support combined license files.
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5.3 Troubleshooting License Manager Problems

This section lists areas of FLEXlm administration that have given customers 
difficulty in the past. Categories are Host ID Problems, Connection Problems on 
p.54, and Other Client Problems on p.55.

5.3.1 Host ID Problems

SYMPTOM When I run the license manager on my machine, it tells me it is the wrong host
ID.

CAUSE The vendor daemon checks the host ID listed on the server line in the license file; 
if it does not match the host ID of the machine it is running on, this message will 
be printed. 

Possible causes include: 

1. You are trying to run the license daemon on a different machine from the 
machine the file was made for.

2. The host ID of the machine you are running on changed (for example, the HP 
ID module was moved, or the CPU board was replaced).

3. The host ID in the license file was modified.

SOLUTION Verify that the host ID of the machine where the vendor daemon (or node-locked 
client program) is being run matches the host ID specified in the license file (on 
the server line for the vendor, or on the feature line for a node-locked client). You 
can run the lmhostid program to see what FLEXlm thinks the host ID is. You 
cannot modify the host ID in the license file. If the host ID of your server machine 
changes, you will have to get a new license file from your software vendor.

5.3.2 Connection Problems

SYMPTOM The application program (or lmstat) can’t connect to the server to check out a
license.

CAUSE The FLEXlm routines in the application are unable to make a TCP connection to 
the server and port specified in the license file. Possible reasons for this are: 

1. The wrong license file is being referenced by the application program.

2. The server machine specified in the license file is down.

3. The vendor daemon specified in the license file is not running.
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4. The hostname in the license file is not recognized by the system.

5. The network between the client machine and the server machine is down.

6. TCP is not running on your machine.

SOLUTION Verify that the application is using the proper license file. Verify that the specified 
server machine is up and reachable by executing another command that uses TCP, 
such as rsh or rlogin, from the client to the server. Verify that the vendor daemon 
is running (you can use the ps command on the server to look for it). Examine the 
license log file to see if any problems are reported, particularly messages 
indicating that the vendor daemon has quit. Run lmstat -a from the server 
machine to verify that the vendor daemon is alive. Run lmstat -a from the client 
machine to verify the connection from client to vendor daemon across the 
network. Try using telnet hostname portnum where hostname and portnum are the 
same as on the server line in your license file.

5.3.3 Other Client Problems

SYMPTOM When I run my application program (or vendor daemon), I get the error bad
code.

CAUSE Possible causes for this are: 

1. The license file was modified (either the host ID on a server line or anything 
on the feature line was changed).

2. The vendor used the wrong version of his license creation program to 
generate your license file (or there is a bug in that process).

SOLUTION You cannot modify the license file. If you need to change something in your 
license file, you must get a new license from Wind River.

SYMPTOM When the second user tries to check out a license, the vendor daemon prints an
error concerning Parameter mismatch in the log file and refuses the license.

CAUSE The most likely cause of this problem is that you are simultaneously trying to run 
two different versions of the application program, and the software vendor has 
not specifically set up the new version for this kind of compatibility. Check the 
license server log file for a comm version mismatch warning message; this 
indicates that someone is running a V1.5 client with a V2.1 or later license server.

SOLUTION Run only the new version  (or old version) of the application.
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5.3.4 Other Server Problems

SYMPTOM When I start lmgrd, it says Retrying socket bind (address in use: port xxxx).

CAUSE The license server listens on the port xxxx that has already been used by another 
server program. 99.44% of the time, if it’s in use, it’s because lmgrd from Wind 
River or another vendor is already running on the port - or was recently killed, 
and the port isn’t freed yet. 

SOLUTION The license.dat file has 27000 at the end of the SERVER line as the port number. 
You can remove it to let lmgrd scan for a free port from 27000 to 27009. You can 
also specify a port number selected by yourself for other concerns such as 
farewell.

SYMPTOM When I start up lmgrd, it says execl failed on my vendor daemon.

CAUSE lmgrd uses execl to start each vendor daemon running. If there is a problem 
starting the vendor daemon, this message is output to the log file. This error is 
typically caused by one of the following: 

1. There is no executable at the location referred to by the license file (and 
printed out in the log file). 

2. The executable does not have the proper protection to be run (the file does not 
have the x bit set, or one of the directories in the path is not readable). 

3. There was an error building the executable, and it cannot be run. 

4. The executable is for a different machine architecture.

SOLUTION Verify that the path to the vendor daemon is absolute, and that it points to the 
executable program itself, not the containing directory (for FLEXlm v1.5). Ensure 
that the file exists by doing an ls -l of the vendor daemon filename(s) specified in 
the log file. Make sure you do this as the same user that started lmgrd. Verify that 
the file is executable. Run the vendor daemon directly from the command line. If 
the vendor daemon is properly linked, it will tell you that it must be run from 
lmgrd; if it crashes or fails to execute, then it is not properly linked.

SYMPTOM The license server keeps reporting lost lock errors in the log file and
exiting.

CAUSE The lockfile is being removed by someone else. There could be another daemon 
running, or the system administrator (or a script) could have deleted the file.

! WARNING:  The portscan feature of lmgrd is only available for FLEXlm v6+ 
licenses. You cannot drop the port numbers when configuring redundant servers.
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SOLUTION Check to see if there is more than one copy of the daemon running. Check for 
more than one lmgrd running as well, since it will restart your vendor daemon 
when it is killed. If more than one lmgrd is running, kill them all, then kill any 
remaining vendor daemons and start one fresh copy of lmgrd. Check to see 
whether a shell script is running that cleans out tmp. If so, try modifying it so that 
it does not delete zero length files.

5.4 Daemon Log File

Daemons generate log files with DAEMON NAME messages where:

The log file, available as %ISIHOME%\ISILM\debug.log, can be used to:

■ Inform users when they need to purchase additional application software 
licenses.

■ Diagnose configuration problems.

■ Diagnose daemon software errors.

5.4.1 Informational Messages

These messages are only informational and do not necessarily indicate an error or 
a problem.

DAEMON 
NAME

Either license daemon or the string from the DAEMON 
line that describes your daemon. In the case where a single 
copy of the daemon cannot handle all of the requested 
licenses, an optional underscore followed by a number 
indicates that this message comes from a forked daemon.

message The text of the message.

Connected to node. This daemon is connected to its peer on node 
node.

CONNECTED, master is name. The license daemons log this message when a 
quorum is up and everyone has selected a 
master.
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DENIED: N feature to user
( N licenses)

user  was denied access to N licenses of 
feature.   

EXITING DUE TO SIGNAL nnn.
EXITING with code nnn.

All daemons list the reason that the daemon 
has exited.

EXPIRED: feature. feature has passed its expiration date.

IN: feature by user
( N licenses).

user has checked back in N licenses of feature.

License Manager server started. The license daemon was started.

Lost connection to host. A daemon can no longer communicate with 
its peer on node host, which can cause the 
clients to have to reconnect, or cause the 
number of daemons to go below the 
minimum number, in which case clients may 
start exiting. If the license daemons lose the 
connection to the master, they will kill all the 
vendor daemons; vendor daemons will shut 
themselves down.

Lost quorum. The daemon lost quorum, so it will only 
process connection requests from other 
daemons.

MULTIPLE xxx servers running.
Please kill, and restart license
daemon.

The license daemon has detected that 
multiple copies of vendor daemon xxx are 
running. The user should kill all xxx daemon 
processes and restart the license daemon.

OUT: feature by user ( N licenses). user has checked out N licenses of feature

RESERVEfeature for HOST name.
RESERVEfeature for USER name.

A license of feature is reserved for either user 
name or host name.

REStarted xxx (internet port nnn ) Vendor daemon xxx was restarted at internet 
port nnn.

Retrying socket bind
(address in use).

The license servers try to bind their sockets 
for approximately 6 minutes if they detect 
“address in use” errors.

Selected (EXISTING) master node. This license daemon has selected an existing 
master (node) as the master.

SERVER shutdown requested. A daemon was requested to shut down via a 
user-generated kill command.
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5.4.2 Configuration Problem Messages

[NEW] Server started for:
feature-list

A (possibly new) server was started for the 
features listed.

Shutting down xxx. The license daemon is shutting down the 
vendor daemon xxx.

SIGCHLD received. Killing child
servers.

A vendor daemon logs this message when a 
shutdown was requested by the license 
daemon.

Started name. The license daemon logs this message 
whenever it starts a new vendor daemon.

Trying connection to node. The daemon is attempting a connection to 
node.

hostname: Not a valid server host,
exiting

This daemon was run on an invalid hostname.

hostname: Wrong hostid, exiting The host ID is wrong for hostname.

BAD CODE for feature-name The specified feature name has a bad 
encryption code.

CANNOT OPEN options file file The options file specified in the license file 
could not be opened.

license daemon: lost all
connections

This message is logged when all the 
connections to a daemon are lost, which often 
indicates a network problem.

lost lock, exiting Error closing lock file.

Unable to re-open lock file The vendor daemon has a problem with its 
lock file, usually because of an attempt to run 
more than one copy of the daemon on a single 
node. Locate the other daemon that is running 
via a ps command, and stop it with kill -9.

NO DAEMON line for daemon The license file does not contain a DAEMON 
line for daemon.

No license service found The TCP license service did not exist.
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5.4.3 Daemon Software Error Messages

No license data for feat , feature
unsupported

There is no feature line for feat in the license 
file.

No features to serve! A vendor daemon found no features to serve. 
This could be caused by bad data in the 
license file.

UNSUPPORTED FEATURE request:
feature by user

The user has requested a feature that this 
vendor daemon does not support. This can 
happen for a number of reasons: the license 
file is bad, the feature has expired, or the 
daemon is accessing the wrong license file.

Unknown host: hostname The hostname specified on a SERVER line in 
the license file does not exist in the network 
database.

NO DAEMON lines, exiting The license daemon logs this message if there 
are no DAEMON lines in the license file. 
Since there are no vendor daemons to start, 
there is nothing to do.

NO DAEMON line for name A vendor daemon logs this error if it cannot 
find its own DAEMON name in the license 
file.

select: message An error in a select system call was detected.

Server exiting The server is exiting. This is normally due to 
an error.
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